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This Non-Road Mobile Machinery Emissions (NRMM) Tool 
user guide has been compiled by Arup. This user guide should 
be used in conjunction with Version 2.0 of the tool. 

Introduction

Arup has been commissioned by Impact on Urban 
Health to undertake an update to a previously created 
tool in partnership on their ‘Exemplar construction 
sites for air quality’ project1. The original tool 
(Version 1.0) was created to calculate the emissions 
from Non-Road Mobile Machinery (NRMM) that 
was used by construction companies taking part in the 
exemplar sites project. 

The tool calculated the emissions from the proposed 
NRMM (specifying the Euro Stage and fuel type) 
and compare it against a baseline (calculated from 
the minimum requirements of NRMM on-site) to 
determine the ‘emission saving’.

Since the creation of the tool, there has been 
positive feedback from the construction industry, 
including how the original tool could be improved 
in terms of the functions within it to increase the 
applicability of the tool.

This updated tool has been developed in partnership 
with Impact on Urban Health, following consultation 
with relevant stakeholders, reviewing emission factors 
and the current NRMM market. Figure 1 illustrates 
the work undertaken.

Figure 1. 
Workflow of the Version 2 
tool update

Purpose
The overarching purpose of this tool is to facilitate 
the reduction of NRMM emissions at construction 
sites. There are four key areas where the tool is 
expected to be used:

1.	 Environmental procurement teams: Developers 
or organisations wishing to introduce 
environmental procurement requirements 
for reducing emissions from NRMM can use 
the tool as a tender response requirement to 
demonstrate how a potential contractor can 
demonstrate emissions reductions. The tool can 
be included as part of the evidence requirements 
and can support future auditing against progress.

2.	 Contractors during operation: Contractors 
managing site works, planning and NRMM 
use can use the tool to calculate the emissions 
from the work and per phase of works. This 
will help calculate which phases are most 
intensive and what equipment choices can 
be made to reduce emissions and meet any 
tender requirements. The tool can be used to 
demonstrate best practice for planning and to 
supplement internal carbon air emissions-based 
reporting. It could also be used for forecasting 
and testing which equipment choice to make 
in order support site emissions reductions.

	– Carbon emission factors and calculations
	– Emerging technology
	– Alternative fuel emissions

Research

	– Incorporate carbon emissions calculations
	– Incorporate additional emissions factors  
(e.g. alternative fuels)

	– Incorporate further functions  
(e.g. GLA NRMM policy compliance) 

Tool  
update

	– Testing
	– Feedback
	– Publishing

Tool  
rollout

	– Construction companies and industry bodies
	– Administrative/regulatory bodies
	– Manufacturers/supplies

Stakeholder 
engagement

3.	 Meeting policy requirements or tracking 
emission reductions: Local authorities or other 
bodies such as developers could use the tool 
to review if they are meeting minimum policy 
requirements such as the GLA NRMM policy 
where applicable. It would be possible to use 
the tools across multiple sites to aggregate up 
emissions savings at a local or borough level.

4.	 Audit teams: The tool can be used to request 
evidence for NRMM reporting and audit 
purposes. Either through existing schemes 
such as those managed by the GLA or other 
local authority or client requirements.

The data collected by the tool (not collected 
externally) has significant value and could be used 
to report on emission reductions at a local authority, 
company or regional level. This is a point for future 
consideration. The tool can also be used more 
widely by those outside of the construction sector as 
equipment such as generators have a range of uses.
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Emissions calculation

Emissions factors

Euro stages

Power rating (kW)

Equipment type  
(Variable speed engine/
constant speed engine)

Estimated hours of use

Alternative fuel 
assumptions/emissions 

factors

NRMM details

Figure 2. 
Flow of data in the tool

About the Tool
The latest tool can be obtained from the Impact on Urban Health. It calculates 
total emissions of nitrogen oxides (NOx), particulate matter (PM10) and 
embodied carbon (CO2e) from NRMM fleets entered.

The tool takes into consideration the following information available:

	– London’s ‘Low Emission Zone’ for NRMM2;

	– The European Monitoring and Evaluation Programme 
and European Environment Agency (EMEP/EEA) air 
pollutant emission inventory guidebook 20193;

	– Centre for Low Emission Construction4 (CLEC) resources;

	– The Department for Energy Security and Net Zero (DESNZ) 
greenhouse gas reporting conversion factors5; and

	– Various construction equipment manufacturer information sheets.

The tool uses the methodology detailed in the EMEP/EEA guidebook  
to determine emission factors for diesel and Liquefied Petroleum Gas  
(LPG) powered NRMM. The tool also uses assumptions on the emissions  
of biodiesel (including Hydrogenated Vegetable Oil (HVO)) from  
CLEC resources6. 

Assumptions have also been made on hybrid emission savings of NOx  
and PM compared to diesel comparatives. Information sheets were gathered 
from manufacturers of hybrid construction equipment and a trend analysis of 
the fuel savings has been incorporated into the tool, which assumed at least 
a 16% saving in both NOx and PM, increasing with the power rating of the 
NRMM equipment. Figure 2 illustrates the flow of data in the tool.
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Using the tool

In order to use the tool, save the tool in a local drive (for example C: drive). 
You must enable macros in your Microsoft Excel security settings before 
opening the spreadsheet. When using Excel 2013, this can be found under 
the “Developer tab”7 in the ribbon. Then:

Macro Security > Macro Settings > Enable All Macros

For versions of Excel prior to 2010, this can be found in:

Tools > Macros > Security Level > Medium

Getting Started
The first input sheet is ‘Site details’. Many of the details are for filing 
purposes. However, the ‘Type of project’ is required to set the construction 
phases as shown in Figure 3. The tool is set as ‘Building’ as default.

The choice of ‘Building’ or ‘Infrastructure’ will influence the project phases 
available as shown below.

GLA Compliance
The ‘GLA Compliance’ sheet calculates the NOx and PM 
emissions from your entered NRMM and compares with  
the ‘benchmark’.

The benchmark is the emissions from the NRMM fleet, assuming  
it is all meeting the minimum GLA NRMM policy requirements. 

Building project

Figure 3.  
User inputs on ‘Site details’ sheet

Infrastructure project
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4. Unique ID. This is your equipment unique identifier. 
To add more rows to the tables, enter a Unique ID in 
the empty row below and the table should expand. 8. Power rating. This input is given in kilowatts (kW)  

and is the rated power of the equipment.

10. EU Stage. This is the emission standard with which the 
NRMM complies. To be able to identify the EU Stage, 
please refer to the CLEC and GLA ‘Practical Guide’, 
available at the GLA NRMM policy website2.

7. Estimated usage. This input is the number of hours the 
equipment will be in operation. This is the activity data used  
to calculate the emissions. Estimations can be calculated,  
for example, by predicting the number of days the equipment 
will be on site and multiplying it by the number of working 
hours of that site (e.g. 10 days x 8 hour working days = 80hrs).

5. Construction Phase. This allows the emissions to be split 
across phases in the line chart to help visualise how emissions 
will be spread across the phases. 

6. Equipment type. This allows the emissions to be attributed to 
equipment types to allow the key contributors to be visualised.

9. Technology/fuel type. The default type is diesel.  
However, the alternatives included are LPG, biodiesel  
(select this if using HVO), hybrid and electric or battery. 

3. Enter the year of construction. This dictates which set  
of NRMM Low Emission Zone standards will be in place 
 in the future, as the standards will get progressively stringent 
over time:

	– From 1 January 2025 the standards will be stage 
IV throughout London (regardless of zone);

	– From 1 of January 2030 the standards will 
be stage V throughout London;

	– From 1 of January 2040 only zero 
emission machinery will be allowed.

1. Enter the GLA NRMM policy area, in which  
the project resides:

	– Central Activity Zone and Canary Wharf

	– Opportunity Area

	– Other area of Greater London

2. The GLA website2 includes a map showing these area. 
Also, when registering a new site on the GLA NRMM 
register, you will be able to drop a pin on the site location 
to identify which zone your site is in.



Impact on Urban Health | Construction emissions reductions Impact on Urban Health | Construction emissions reductionsArup Arup12 13

Carbon Breakdown
The input procedure is the same for the ‘Carbon Breakdown’ 
sheet. However, the output is embodied carbon (CO2e).

Scenario Comparison
Being able to compare the proposed equipment and total emissions 
with a future alternative scenario is highly valuable as it allows the 
user to test which equipment options need to be changed or improved 
in order to reach a set emission reduction goal.

The sheet will populate the baseline scenario with the information 
from the previous tabs and the user can alter the selections in the 
alternative scenario to calculate the changes in emissions.

The input procedure is also the same for the ‘Scenario Comparison’ 
sheet, but is doubled up for the baseline and future scenario to be able 
to set a second scenario that is not automatically set at the minimum 
GLA NRMM policy requirements. This sheet calculates the emissions 
for NOx, PM and carbon for comparison. 

These is also an option to apply a blanket % emission reduction  
for each pollutant, for each scenario to be able to test scenarios.

12.

13.

Once you have populated the inputs, click on the 
‘Update’ button and the Output calculations will 
update along with the information dashboard.

You should now have a dashboard showing the 
comparison between project (your site) and benchmark 
(GLA NRMM policy minimum requirements) emissions, 
emissions through the phases, key contributors and the % 
of NOx and PM under or over the benchmark.

11. There are options to enter abatement technology that 
would result in the NRMM meeting a more stringent 
EU Stage emission standard (to be entered in the 
‘Resultant EU Stage’ column). If there is plant with 
abatement technology retrofitted, please refer to the 
Energy Saving Trust guidance8 on resultant EU Stage 
from certified abatement. If your equipment is not fitted 
with abatement, you do not need to fill these cells. 
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Limitations

Some alternative fuel options have not been included.  
For example, Hydrogen as a combustion fuel has not been 
included in this version due to the limited data on NOx and 
PM emissions on the combustion of this fuel in NRMM. 

For carbon emissions, assumptions would need to be made on the 
production of the Hydrogen fuel, which could significantly vary the CO2e.

The emission calculations in the tool apply EMEP/EEA emissions 
guidebook methodology. It should be noted that the basis of this are 
the emission standards for NRMM and that real-world emission from 
NRMM will vary in conformity to the emission standards (below and 
above), as studies suggest (C.D. Desouza et al. 20209). 

Therefore, there is inherent uncertainty in the emissions calculated 
and assumptions made. However, the purpose of the tool is to support 
equipment users with making choices which will reduce emissions and 
allow a comparison of emissions between scenarios, rather than providing 
estimates for detailed reporting purposes and therefore should be used  
with due consideration.

Glossary and Definitions

Abbreviation Details

Arup Ove Arup & Partners Ltd

CLEC Centre for Low Emission Construction

DESNZ Department for Energy Security and Net Zero

CO2e Embodied carbon

EMEP/EEA European Monitoring and Evaluation Programme  
and European Environment Agency

GLA Greater London Authority

HVO Hydrogenated Vegetable Oil

kW Kilowatts

LPG Liquefied Petroleum Gas

NOx Nitrogen Oxides

NRMM Non-Road Mobile Machinery

PM10 Particulate matter
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Disclaimer

This model and any information contained within it has 
been prepared for the named Client and strictly for the 
purpose of the titled project and has been developed by 
Arup based on certain data sources and assumptions. 
No third parties shall have a right to rely on the model 
without the written permission of Arup.

Arup accepts no liability to any third party whatsoever for any use of 
the model and gives no warranty express or implied as to the adequacy, 
accuracy, completeness, or reasonableness of the model or the information 
used or contained within it. The recipient of the model should make (and 
will be deemed to have made) its own review of the model. 

In no event will Arup be liable for any decision made or action taken as a 
result of any use or reliance of the model that is not expressly authorised 
in writing by Arup and Arup shall have no liability in contract or in tort, 
in negligence, for breach of statutory duty or otherwise for any claims, 
actions, demands, proceedings, expenses, costs or losses of any kind 
which may arise out of or as a consequence of such use.

Endnotes
1	 https://urbanhealth.org.uk/partnerships/current-partnerships/exemplar-air-quality-construction-sites
2	 https://www.london.gov.uk/programmes-and-strategies/environment-and-climate-change/pollution-and-air-quality/nrmm
3	 EMEP/EEA air pollutant emission inventory guidebook 2019 — European Environment Agency (europa.eu)
4	 https://clec.uk/
5	 Greenhouse gas reporting: conversion factors 2023 - GOV.UK (www.gov.uk)
6	 CLEC (2019) ‘Best in Class’ Guidance on Dust and Emissions from Construction: LLECP BIC Guidance_FINAL.pdf (clec.uk)
7	 Or go to File > Options > Customise ribbon and tick the Developer box on the right hand side menu
8	  https://energ-ysavingtrust.org.uk/service/non-road-mobile-machinery-certification/
9	 C.D. Desouza, D.J. Marsh, S.D. Beevers, N. Molden, D.C. Green, Real-world emissions from non-road mobile machinery in 
	 London, Atmospheric Environment, Volume 223, 2020, 117301, ISSN 1352-2310, https://doi.org/10.1016/j.atmosenv.2020.117301.



Contact:
James Bellinger 
Associate Director | Climate and Sustainability Services 
CEnv, CSci

t: +44 207 755 4185 
e: james.bellinger@arup.com

8 Fitzroy Street, London,  
W1T 4BJ, United Kingdom

arup.com

http://www.arup.com/

	Figure 1. Project timeline
	Figure 2. Emissions from construction
	Figure 3. NRMM zones 
	Introduction
	Purpose
	About the Tool

	Using the tool
	Getting Started
	GLA Compliance
	Carbon Breakdown
	Scenario Comparison

	Limitations
	Glossary and Definitions
	Disclaimer

